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1 Introduction

X-Lite is a softphone from CounterPath that enables you to make VoIP voice and video calls, send and receive 
instant messages, share online status (presence) information, and exchange files. X-Lite implements SIP-based 
standards for phone calls, IM and presence, allowing you to work with different VoIP service providers.

Standard Telephone Features
The CounterPath X-Lite for Mac softphone has all standard telephone features, including:

• Call display and Message Waiting Indicator (MWI).
• Speakerphone and Mute.
• Redial, Hold, Do Not Disturb.
• Call history – list of received, missed, and dialed calls.
• Three-party audio conferencing.
• Three-party video conferencing.

Enhanced Features and Functions
X-Lite also supports the following features and functions:

• Video
• IM and presence using the SIP SIMPLE protocol
• Contact list containing the individual user’s contacts
• Acoustic echo cancellation, automatic gain control, voice activity detection.
• Support for DTMF (RFC 2833 or inband DTMF). 
• Support for the following audio codecs:

G.711aLaw, G.711uLaw, G.722, OPUS, Speex, Speex Wideband.

• Support for the following video codecs:
H.263, H.263+ 1998.

• Compliance to 3261 SIP standard. 
• Support for these firewall traversal solutions: STUN, TURN, or ICE.
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2 Installation and Setup

2.1 Getting Ready

Account Information
After choosing a VoIP service provider, you will need the following information:

• User name and domain. For example, 1331@domainA.com
• Password
• Authorization Name (if applicable)
• Firewall traversal and other network information; see “Configuring X-Lite” on page 29.
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2.2 Configuring X-Lite

Setting up Notifications
X-Lite uses OS notifications. Make sure that the notifications are set up for X-Lite in system preferences.
From the menu, click Apple logo > System Preferences > Notifications. In the notification center, choose X-
Lite. Choose Banner or Alerts for the alert style. For details on incoming call notifications, see page 15.

Setting up Accounts
After obtaining SIP account information from your VoIP service provider, you can set up X-Lite accounts.

1. From the menu bar, choose X-Lite > Preferences > Accounts. The Account list appears with one account 
(the Mac Address Book account) enabled; see below.

2. Click the + button and choose New SIP Account. The SIP Account window opens. 

3. In the General tab, complete the User Details area with the information obtained from your VoIP service 
provider. 

4. Complete the remaining tabs as specified by your service provider or to suit your setup. Settings that you 
may need to change immediately include:

• General tab, Domain Proxy area.
• Topology tab, if your computer is on a network and/or behind a firewall.
For more information, see page 29.

5. Click OK; the account is enabled and registered; check the account list to make sure the account registers 
successfully.

 

4



X-Lite for Mac User Guide
Populating your Contact List
Typically, you will want to create contacts in order to easily make phone calls and send IMs. 

You can:

• Add addresses to the Contact list one by one. See page 20.
• During a call that you place or receive, you can add the other party to your contact list. See “Handling an 

Established Call” on page 12.
For general information on contacts, see page 20.

2.3 Troubleshooting
X-Lite includes tools for helping you troubleshoot problems. From the menu, choose Help > Troubleshooting.

• Audio tab: While you are on a phone call, you can test the quality of the audio. Note that to perform a valid 
test, you should be on an established call (not a call attempt). 

• Video tab: You can verify that your camera is working.
• Devices tab: You can verify that your microphone and speakers are working and can set the volume to a 

comfortable level without having to actually place a phone call.
• Diagnostics tab: If none of the other tabs help you solve your problem.
5



3 Making Phone Calls

3.1 The Onscreen Softphone 

Call entry field 
See page 8.

Resources. 
See page 19

Close window

Minimize to dock

Resize softphone

The Call button
6
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The X-Lite Menu

The menu contains the following items that are specific to X-Lite:

• X-Lite > Preferences. See page 38. 
• View. Changes how X-Lite looks. 
• Contacts. Lets you work with contacts.
• Help. Provides access to various service-related features. 

Receiving an Online Status Request
When you start X-Lite, one of the first things you may see (if presence is enabled) is an Online Status Request 
dialog. See “Sharing Online Status” on page 24. 
7
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3.2 Placing a Call
Place the call as described in the table below. The outgoing call opens in its own call panel, below any other 
existing call panels. You will hear a ringing tone while X-Lite attempts to make a connection.

Option From the... Description

Keying Dialpad or computer 
keyboard

1. Enter the number or address in the call entry field using the dialpad 
or the computer keyboard. 

If entering a softphone address, you can enter the entire address 
(6045551212@domainA.com) or just the number (6045551212).
As you type, a suggestion for completing the entry may appear. 
Choose the suggestion or keep typing.

2. Click the Call button or press Enter. 

Control-click a contact or 
previous call

Contacts or History tab Control-click an entry from the Contacts or History tab and choose Call 
or Video Call. 
(If the tab contains lots of entries, first search or filter the list.)

Double-click a contact Contacts tab Contacts have a “double-click” action (page 38) that either makes an 
audio phone call or starts an IM.

Single-click a contact Contacts tab Hover over the right side of the contact to reveal the click-to-call 
button. Click to place a call using the primary phone number for this 
contact.

Redial Redial button • When the call entry field is empty, click the Call button.
• Or click the arrow in the call entry field and select a recent call. 

An audio call is placed.

Dialing Dialpad 1. If the dialpad is not visible, click the Dialpad tab at the bottom.
2. Click the numbers on the dialpad to enter the phone number.
3. Click the Call button or press Enter.

From an instant message Messages window Click the menu at the top of the Messages window and choose Call.
8
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Placing a Call

Dealing with an Auto Attendant

If you know that your call will be answered by an auto attendant and you know what menu items you will 
choose, you can include those menu items (DTMF) in the phone number when you dial it:

• Before the first DTMF number, include at least one capital P.
• You can include other Ps. Each P causes X-Lite to wait one second before sending the next character. 
• At the end of the input, you must include a ; character.

Example: To dial a number, add a 3-second delay and then press 44, enter this in the call entry field:

604551212PPP44;

Example: To dial a number, add a 6-second delay, then press 1 then 3 then 2, each with a two second delay:

604551212PPPPPP1PP3PP2;

A capital X or , (comma) can be used instead of P. The following will work in the same way as the first example 
above:

604551212XXX44;

Type a number or name of a contact in the call entry field.

Click to place the call

Auto complete suggestions

For information on working with the call, see 
“Handling an Established Call” on page 12. 
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Placing another Call
You can place another call. The first call will be put on hold. 

Existing call is automatically 
put on hold

Place the call in 
the usual way

New outgoing call

Switch between the different calls by clicking 
Resume on the desired call panel. That call 
becomes the active call and all other calls 
are put on hold.
10
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3.3 Handling Incoming Calls
X-Lite must be running to answer incoming calls. (If X-Lite is not running, incoming calls may be directed to 
voicemail; check with your VoIP service provider.)

When X-Lite is in the foreground, the new call appears in its own call panel. When X-Lite is in the background 
(the focus is on other application), the incoming call notification appears in the upper-right corner. To receive 
notifications, make sure that you configured both system preferences on Mac OS (page 4) as well as X-Lite’s 
alerts preferences (page 39).

When X-Lite Is in Foreground

When X-Lite Is in Background
The Call Alert box appears, even if X-Lite is minimized. For information on call alerts, see page 39.

The notifications do not indicate whether the incoming call is an audio or video call. If the incoming call is a 
video call, X-Lite will answer with video.

Click. If you are on another call, 
that first call is automatically put 
on hold. You are now talking to the 
new caller.

The Alert style shows buttons The Banners style goes away automatically. 
Clicking the banner answers the call
11



CounterPath Corporation
3.4 Handling an Established Call

Ending a Call
Click the End call button on the Call panel (the call can be active or on hold). The call panel closes after a few 
seconds.

Speakerphone (when yellow) 
or headset mode (when gray)

Place another call 
The current call is automatically 
put on hold). See page 10

Conference Calls
See page 14

Instant Message
See page 17

Add as Contact
If a plus symbol appears here, 
you can add the current caller as 
a contact. See “Adding a Contact 
using an Existing Address” on 
page 21.

Add video. 
See page 13

Hold and 
resume 

Mute what you 
hear on all calls

Mute your 
voice on this 
call

Volume on all 
calls
12
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3.5  Handling Video Calls
Placing a Video Call

Adding Video
If you have a camera, you can click Start Video to add video to an established call. When you add video, the 
other party may (or may not) start sending their video to you.

Other Party Adds Video
If the other party starts their video, your video panel automatically opens and the video is played. You can start 
sending your own video, if desired (and assuming you have a camera) by clicking Start Video on the call panel.

Pausing and Resuming Video
Click Stop Video on the call panel or close the video window to pause sending your video.

Click Start Video to resume sending your video; the video window will open. 

Click the down arrow and choose 
Video call.
If you mostly make video calls, you 
can Option-click this down arrow to 
reveal the “Set Video Call as default 
action” menu item.

From the Dashboard

Start or stop video
13
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3.6 Conference Calls

Starting a Conference Call

From the Dashboard

From an Existing Call 

• Enter the number or address 
by typing

• Or select from the redial list
Then choose Start conference call

• Or drag a contact or history 
item

From One Established Call

From Two Established Call
14
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Managing the Conference

Adding another Participant
If your conference currently has only one participant, you can add the other participant in any of these ways:

• Control-click on a contact and choose Add to Conference Call.
• In the conference call panel, click Invite to Conference Call and then click Add.
• Add in a separate call that is not part of the conference call: In the call panel for the individual call, click the 

down arrow and choose Merge Calls. This call is added to the conference call.

Send an Instant Message
Click the down arrow beside a participant name and choose Send Instant Message.

Removing a Participant
To remove one call from the conference, click the down arrow beside a participant name and choose Separate. 
The call becomes a separate call.

Ending the Conference
To hang up on everyone, click the End button.

Suspending the Conference
To suspend the conference, click the Hold button. All participants are put on hold. 

If you need to speak to one participant separately, put the conference on hold, separate the one participant from 
the conference, take that person off hold. When done, merge the participant back into the call.

Participant menu

Mute. When you mute during a video call, you 
may also want to click Stop Video to stop the 
video feed.
15
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Video Conference Calls

Starting a Conference with Video
When you start a conference from established calls, video is included if at least one of the calls already includes 
video. Video is sent to all the participants.

When you start a conference from scratch, video is not included. You can open your video window and choose 
to add video at any time. Video is sent to all the participants.

How Video Is Shared
The conference host (the person who starts the conference) serves as the host for other video. Whatever the 
conference host is receiving will automatically be sent to the other parties. 

If the conference host pauses or stops video, other participants will no longer receive video.

3.7 Voicemail
If your service includes voicemail and you have set up voicemail options (page 32), then when you have 
voicemail messages, the voicemail icon appears at the top of the phone (the icon may include a number). You 
can click the icon to automatically connect to voicemail and listen to your messages.

“Video” appears beside each person

Start and stop sending your video to all participants

Closing the video window stops 
sending video.

Start and stop sending your video to all participants

Voicemail icon
16
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4 Other X-Lite Features

4.1 Instant Messaging

Sending an IM
1. You can send an IM to a contact who has a softphone address.

2. Type the message. Include emoticons and formatting (Ctrl+B, Ctrl+I, Ctrl+U), as desired. 

To insert a return in the message, press Ctrl+Enter. (You can control the behavior of Enter and of 
Ctrl+Enter; see page 30.)

3. Click the Send icon or press Enter. 

Receiving an IM
When an IM is received, either the Messages window or a notification pops up. (To control which window 
appears, from the menu choose X-Lite > Preferences > Alerts & Sounds.)

From the Contacts tab Control-click on the contact and choose Send IM. The contact must have a softphone 
address.
Or click on the IM icon that appears to the right of the contact name. 

An active phone call If the person is a contact, choose Send Instant Message from the call panel menu.

An active conference call If the participant is a contact, choose Send Instant Message from the participant menu.

From the Messages window Click the New Conversation icon beside the Search field and type a number or name.

Click to select more actions
17



4.2 Viewing Messages
To view your recent IM activity for any contact, perform one of these actions:

• Click the Messages window icon:

• Press Shift + Command + M.
• On the menu bar, choose View > Show Messages. 

Search all messages.

Click for more actions 
such as exporting 
conversation.

Clicking the x icon deletes the session.

The session may be greyed out. Typically it 
means that the account used for the session is 
not registered, or the group chat has ended.
18



5 The Contacts Tab

The Contacts tab displays your contacts. Each contact is shown with presence information and icons for single-
click phoning and IMing.

You can change the detail and layout of the contact list: from the menu bar choose Contacts and set the desired 
options.

Add a Contact

The online status of 
contacts. See 
page 24.

Search field

Contacts are typically organized into 
groups. X-Lite includes built-in groups. 
You can add more groups, as desired.

If the Contacts tab is 
not showing, go to 
the menu bar and 
choose View > Show 
Contacts.
19
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5.1 Managing Contacts and Groups

Adding a Contact

Click , or control-click a group and choose Add Contact to Group. The Contact dialog appears.

Field Description

Contact Summary

Group Click to show the list of groups. Check each group this contact should belong to. 

Primary Call If the contact has more than one number, select the primary number. This number will be used with 
single-click calling.

Primary Presence This field appears only the contact has more than one Softphone number. The primary presence is 
used as follows:
• The presence icon on the contact list shows the online status for this address.
• The single-click action for instant messaging uses this address.

You can still send IMs to this person at their other addresses, but you must right-click and choose 
from the context menu.

Other Sections

Display Name (required) The display name for this source of information.

First Name, Last Name Optional.

Contact Methods Enter as many contact methods as you want. 
Enter a person’s IM address by choosing Softphone as the type. 

Presence This field is automatically populated when you enter an address in the Softphone or Instant Message 
field. It indicates that you are sharing online presence information using this address. The address is 
also shown in the list in the Primary presence field, above.

The new number appears 
in the list

To enter a phone number, select 
the type, enter the number, and 
click +
20
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Example

This example shows how to add a contact when your VoIP service supports online availability via your SIP 
account.

Adding a Contact using an Existing Address
You can add a contact by capturing existing information: 

• If you are on a phone call with a person who is not a contact, click the Add to Contacts icon in the call 
panel.

• On the History tab, select an entry that is not a contact. Control-click and choose Add Contact.

The Contact Profile dialog appears. Complete the dialog as desired and press OK.

If the contact method is Softphone or Instant Message, an online status request is sent to this person. See 
“Sharing Online Status” on page 24.

Enter the person’s softphone number in 
the Softphone field

As soon as you add a Softphone entry, this field 
automatically appears. X-Lite will share online 
presence information with this person using this 
phone number.

In addition, these fields appear. See the table for 
information on these fields.
21
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Modifying the Contact List

Changing Contact Information

To change the information for a contact, control-click the contact and choose Edit Profile. The Contact dialog 
appears (see page 20). 

Moving or Deleting a Contact
• To drag one or more contacts to a different group, select them and drag to the title bar of the new group.
• To delete one or more contacts, select them, control-click, and choose Delete or Delete Selected Items. The 

contacts are removed from this group. If a contact belongs to several groups, it is removed from all groups.

Adding, Deleting or Renaming Groups

Select any group, control-click, and choose the appropriate menu item.

Contacts that have no group appear under “Ungrouped Contacts.” You can delete, but not rename, this group.
22
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5.2 Using Contacts

See page 17

You can watch the contact’s online status, if the contact has a softphone 
address.
See page 26 for the meaning of the online status icons. 
See “Sharing Online Status” on page 24 for information on obtaining online 
status information.

See page 28

Click to send an IM using 
the primary presence 
address for this contact. 

Hover to reveal icons

Click to call using the 
primary phone 
number. 
23
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5.3 Sharing Online Status
You can publish your online status to contacts who have softphone address, and you can set up X-Lite to view 
the online status of other contacts. Typical online statuses are available, on the phone, busy, and so on.

Sharing Online Status

Watching Others’ Status 
If a contact has a SIP address in the Softphone field, X-Lite will automatically obtain status information for this 
address.

When you choose to share presence information, X-Lite sends the contact a notification request. The request 
asks that you be able to see that person’s status. If the person allows this request, then the icon beside their name 
(in your Contacts) becomes color coded to specify their status. 

Your online status

Online status of other 
people

This person is either logged out 
or is not publishing their online 
status

This person has no icon 
because you are not 
subscribing to their online 
status
24
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Allowing Other Parties to See your Status (Publishing your Status)
Continuing from above, when the other person allows the notification request, your name is added to their 
contact list. As soon as you are added to their list, a request is sent back to you requesting that they be able to 
see you. X-Lite accepts this request automatically, and the other person can now see your status.

Receiving an Online Status Request
Someone who is not one of your contacts may add you as a contact on their end, and may include your SIP 
address. In this case, X-Lite receives an online status request.
25
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Setting your Online Status

Changing your Status
Click the down arrow beside the online status indicator on X-Lite, and select the desired online status. Along 
with a status, you can set a custom note by selecting and replacing the text such as “Available” or “Busy” beside 
the status icon. 

Setting up Online Status Indicators
 

Indicator Meaning for your Status Meaning for Others’ Status

Available Either:
• You have set your status to this value. 
• X-Lite has determined that you are logged on but not on the phone 

or idle.

When you have this status, X-Lite will automatically detect when 
you are idle or on the phone, and change the status to match.

You can contact this person.

Busy You have set your status to this value. X-Lite will never 
automatically switch you out of this status; you must switch 
yourself.

You can contact this person.

Away You have set your status to this value. X-Lite will never 
automatically switch you out of this status; you must switch yourself.

You can contact this person.

On the phone Either:
• You have set your status to this value. In this case, X-Lite will 

never automatically switch you out of this status; you must switch 
yourself.

• You started a phone call when your status was “Available”. When 
your call finishes, your status reverts to “Available”.

You can contact this person.

Idle You have not moved or clicked the mouse or pressed a keyboard key 
for the Idle period. To set the Idle period see page 38.
As soon as you click the mouse or keyboard, your status changes to 
“Available”.

You can contact this person.

Offline You have set your status to this value. The other person sees you as 
offline, even though you are not actually offline. The other person 
cannot tell the difference between this status and you really being 
offline.

The contact is either not logged on 
or does not want to share online 
status. 

No icon Not applicable You are not watching the other 
person’s online status.

Replace the text with your own note such as:
26



6 Using Other Resources

6.1 The History Tab

Managing the List of Calls
You can control-click on an entry in a list to:

• Delete the call.
• Delete all entries in this list.
• Edit the profile if the entry is a contact.
• Add as contact. The Contact dialog appears. See “Adding a Contact using an Existing Address” on page 21.

Phoning from History
You can control-click on an entry to place a call to this person, using the contact method that was used for this 
call. You can:

• Control-click on an entry and select Call or Video Call to place a call to this person, using the contact 
method that was used for this call. 

• Place a call to this person and add them to a conference call that is in progress. For more information on 
conference calls, see page 14. 

Green: Outgoing call, either 
attempted or established

Red: Incoming missed call

Blue: Incoming call that was 
answered

Filter list
From the menu bar, choose 
View > Show History
27
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6.2 The Favorites Tab
You can create favorites from your contact list. They will be displayed in both the contact list and in the 
Favorites tab.

Select the desired contacts, then control-click and choose Add to Favorites. 

You can perform nearly all the same 
actions on the contact in Favorites as 
you can in the contact list.

Removes from Favorites but does 
not remove from the contact list

Removes from Favorites and the 
contact list

Menu for other actions

o to the menu bar and choose View > Show Favorites.

Quick links to phone or IM 
this person 
28



7 Configuring X-Lite

From the menu bar, choose X-Lite > Preferences. The Preferences window appears.

7.1 Account

Setting up an Account to Make Phone Calls
Choose X-Lite > Preferences and click the Accounts tab. Complete the tabs as described on the 
following pages.

When you click OK on any tab, the Account list reappears The 
newly created account now appears in the list.
29
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Account – General

Field Description
Account name If desired, change the account name to something that is meaningful to you. For example, the 

name of the VoIP service provider.
Protocol Read-only. Always specifies SIP.
Use for Call If checked, this account is eligible to be used for phone calls. If unchecked, this account will 

never be used for placing phone calls.
Use for IM/Presence If checked, this account is eligible to be used for IM and online status (presence). If 

unchecked, this account will never be used for IM and online status.

User Details
User ID Typically the account number for the softphone account. For example, 6045551212 or 2766. 

Provided by your VoIP service provider. 
Domain For example, domainA.com. Provided by your VoIP service provider.
Password Provided by your VoIP service provider.
Display name This name is displayed in the X-Lite title bar.

Other people will see you as this name.
Authorization name May not be required. If it is required, it will be provided by your VoIP service provider.

Domain Proxy
Register with domain and receive 
calls

Check this box if you want to register with your VoIP service provider, so that you can receive 
incoming calls.
Typically, this field is checked. 
This field must be left unchecked when, for example, your level of service does not include 
the ability to receive incoming calls. In that case, turning this field on may cause registration 
to fail (when you close the Account Properties window).

Send outbound via Choose the setting specified by your VoIP service provider: 
• Domain: If your VoIP service provider requires that traffic be directed to proxies that are 

discovered via the domain.
• Proxy Address: If your VoIP service provider has an outbound proxy address and requires 

that you provide the address to X-Lite. For the address enter a domain name (for example, 
domain.com) or an IP address (for example, 123.456.789.012). 

If you are using X-Lite in a test lab, it is possible that neither of these settings is suitable; see 
page 37 for a third way to direct traffic.

Fields with an asterisk are 
required
30
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Dial Plan Information about the syntax of the numbers used by this VoIP service provider. 
Provided by the service provider. The default plan is:
#1\a\a.T;match=1;prestrip=2;
For information on determining whether you need to modify the default dial plan, see 
page 50. 

Field Description
31
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Account – Voicemail

These settings let you set up to interact with your VoIP service provider’s voicemail service. 
Your service provider may provide the ability to set up for voicemail outside of X-Lite, for example, by phoning 
a softphone address and following the voice prompts, or by accessing a website. 
Check with your service provider to determine if another setup mechanism is available. If so, check what the 
settings are in that setup, and make sure you enter compatible information in X-Lite. 
 

Field Description
Check for voicemail Set the checkbox in one of these ways:

• Check the box if X-Lite must subscribe to be notified when there is a voicemail for 
you. In other words, to configure for “subscribe for message waiting”.

• Clear the checkbox if the service provider’s voicemail server sends notifications 
without X-Lite subscribing. In other words, to configure for “implicit subscription”.

• Clear the checkbox if the service provider does not support voicemail. 

Check with your VoIP service provider for the correct configuration.

Voicemail is offered by your VoIP service provider; it is not part of X-Lite. Contact your 
service provider for information on using voicemail.

Number to dial for checking voicemail Optional, but complete this field only if your VoIP service includes voicemail. 
• Completing this field activates the voicemail icon in the tool bar. When you click this 

icon, X-Lite will dial this number. You will be connected to your service provider’s 
voicemail and can listen to your messages. 

• If you leave this field empty, then this icon will not work; you will have to manually 
dial this number in order to connect to voicemail.

Enter the number or SIP address provided by your VoIP service provider.
Number for sending calls to voicemail Complete only if your VoIP service includes voicemail. Optional, but you must 

complete it if you check “Send calls to voicemail if unanswered”.
This is the number that incoming calls will be forwarded to if they are unanswered after 
the specified interval (below).
If you leave this field empty, then X-Lite will never forward calls to your service 
providers’ voicemail. However, most VoIP service providers have their own mechanism 
for sending unanswered phone calls to voicemail. So leaving this field blank does not 
mean that forward-to-voicemail does not work. 
Enter the number provided by your VoIP service provider.
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Send calls to voicemail if unanswered Complete only if your VoIP service includes voicemail.
To send to voicemail after the specified number of seconds. 
Your service provider may also provide a similar feature that is set up outside of X-Lite. 
If so, make sure you do not enter competing information in X-Lite and in the service 
provider’s user interface. For example, if you turn off this field, make sure the same 
feature at your service provider is also turned off. Otherwise, all your calls will continue 
to be forwarded.

Field Description
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Account – Topology

Field Description
Firewall traversal 
method

Choose the setting recommended by your VoIP service provider:
• Auto detect using ICE: Automatically determine the contact address for signaling traffic.

Advertise the local IP, public IP (discovered via STUN, if available) and media relay IP and use these to 
automatically determine the best route for media traffic during calls.

• Discover public IP address: Advertise the public IP address (discovered via STUN) for the contact 
address for signaling traffic, and for the connection address for media traffic.

• Use media relay (TURN): Advertise the public IP address (discovered via STUN) for the contact address 
for signaling traffic.

Advertise the address of a media relay server (discovered via TURN) for the connection address for 
media traffic.

• None: Advertise the local IP address only for both signaling and media traffic.
Server address • Empty: Discover the address of the firewall traversal server (the STUN or TURN server), if available, 

using DNS SRV. 
• Specified: Use the firewall traversal server specified as either an IP address or a fully qualified hostname.

If you use the “Auto detect using ICE” option, then you can only enter a STUN server here. Don’t enter 
a TURN server because when ICE is used, TURN is not supported.

Range of ports The appropriate setting depends on your computer setup:
• Checked: If your computer is behind a restrictive firewall that only allows specific port ranges to be 

used. Enter the range of ports to use for your SIP account. (You must also open those ports on your 
firewall; refer to applicable firewall documentation for information.)

• Unchecked: If your computer is not behind a restrictive firewall.   
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Account – Presence

Presence allows other softphone users to see your online status, and also allows you to see the online status of 
others. 

This tab lets you set up to share presence information with contacts. 

Field Description
Mode Peer-to-Peer is supported. 
Refresh interval Enter the value specified by your VoIP service provider. 
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Account – Transport

Field Description
Signaling Transport Contact your VoIP service provider to identify the types of transport that are supported. 

Then choose a supported transport:
• Automatic: X-Lite sets up the transport based on the capabilities of the network and the 

X-Lite computer. Choose this option if you do not care which transport is used.
• TCP
• UDP
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Account – Advanced

Field Description

Register Settings
Reregister every The time interval between X-Lite’s attempts to reregister in order to refresh the account 

registration with the VoIP service provider for this account. A value of zero means not to 
reregister after the initial registration.
This value is placed in the “Expires” header field of the REGISTER message.

Minimum time If the reregistration fails, X-Lite will wait this amount of time, then attempt to reregister. If the 
second attempt fails, X-Lite will wait twice this time and try again, then four times this time, and 
so on, until reregistration succeeds.

Maximum time In this version of X-Lite, this setting has no effect.

Timers
Enable session timers
Default session time

A session timer is a mechanism to detect whether a call session is still active from the signaling 
point of view. When the timer expires, a refresh is sent from one party to the other. The timer is 
then reset.
• Turn on to enable session timer. Enter a value in Default session time. 
• Turn off to disable session timer; refreshes will never be sent.

Session timer preference • Inactive: A session timer will be used only when it is explicitly required by the remote party.
• Optional: A session timer will be used whenever the remote party supports and uses it.
• Required: A session timer will be a requirement for the remote party to be able to establish a 

call session.
• Always: A session timer will always be used in all sessions, regardless of whether or not the 

remote party supports/uses it. 
Send SIP keep-alives Typically on, to instruct X-Lite to send SIP keep-alive messages in order to maintain a “pinhole” 

through your firewall for SIP messaging.
Use rport Typically on.
Send outgoing request 
directly to target 

In this version of X-Lite, this setting has no effect.

Use old style hold Check this box only if your VoIP service provider advises you to do so.
37



CounterPath Corporation
7.2 General Preferences
From the menu bar, choose X-Lite > Preferences. The Preferences window appears. All the tabs on this window 
except for “Accounts” are preferences tabs. These tabs let you control the way that you work with X-Lite. 

The icons (other than Accounts) let you set up general features of X-Lite.

Preferences – Application

This panel lets you set your preferences for general UI behavior.
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Preferences – Alerts & Sounds

This panel lets you control the alert box and lets you assign sounds. 

Enable Alert Displays

You can control whether notifications are displayed in different situations. To receive notifications:

1. Set up to use either Banners or Alerts under OS’s system preferences (page 4). When “Enable alert 
displays” is on, X-Lite shows either a banner or an alert for selected situations. 

2. On the Alerts tab, check the situations for which you want to receive an alert.

• With “For an incoming Message”, if you check this option, an alert or banner (as specified in the OS) 
will appear when you have an IM. If you uncheck this option, the Messages window will appear when 
you have an IM.

• With other situations, if you check the option, an alert or banner will appear. If you uncheck the option, 
no alert or banner will appear.

Assigning Sounds

You can assign specific sounds to a variety of actions or “events”.

1. Select the Enable sounds check box and select the check boxes for each desired event, or clear the Enable 
sounds check box to disable all sounds.

2. If enabling sounds, you can change the sound for each event: select the individual event. The value in 
Sound preference will change. Select the desired sound.

You can import sounds; these will be added to the list of sounds you can choose from when assigning a sound to 
an event.
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Preferences – Devices

X-Lite automatically detects devices at each startup. On this panel, you can choose the device to use for X-Lite.

Field Description

Automatic gain control This feature is typically on.

Reduce background noise Automatically attempts to remove background noise.
Typically on for the speakerphone.

Test Devices For information on the Test Devices button, see “Troubleshooting” on page 45.

Test Camera You can verify that your camera is working and adjust settings.

Headset Mode

Microphone,
Speaker 

Change these fields only if you want to override the devices that X-Lite automatically selected.
In both these fields, select the headset you are using.
The headset is the device that is usually used for the speaker (the sound you hear) and microphone 
(recording your voice). The only situation in which the headset is not used is when the Speaker 
Phone button on the dialpad is pressed. 
Therefore, unless you will always be using X-Lite in speakerphone mode, you must make a 
selection here.
Select the headset in both the Speaker device field and Microphone device field.

Speakerphone Mode

Microphone 
Speaker

Same as headset mode, but for the device to use when speakerphone is one (on the toolbar). 
Select None if you do not have a speaker phone. The Speaker Phone button on the dialpad will be 
disabled.
You can set different devices for the speaker and microphone: for example, you can set the speaker 
to the speakerphone and set the microphone to your headset.

Reduce echo Turning this feature on improves sound quality. This feature is typically on.

Other Devices

Ring on The device where you want to hear the phone ringing.
Change this field only if you want to override the devices that X-Lite automatically selected.

Camera This field appears only on versions of X-Lite that include video functionality.
Change this field only if you want to override the devices that X-Lite automatically selected.
Select the camera model.
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Max Resolution Leave at standard, or change the size as follows:
• Set it to high if you have a good camera and a computer with a fast CPU. You will know that you 

have set the size too large if:

Your computer slows down (the video is using too much CPU)
The video shows black areas or is slow or jerky.

• Typically set it to low only in special situations, for example, when using wi-fi in a hotel. You 
will know that you have set the size too small if the video is fuzzy.

Field Description
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Preferences – Codecs

Audio Codecs

This panel shows all the audio codecs that are included in X-Lite. You can enable or disable codecs as desired. 

Typically, leave the enabled codecs list at its default state; only enable or disable a codec if advised to do so by 
your VoIP service provider.

With only one codec enabled, all calls made will use that codec. With more than one codec enabled, X-Lite 
offers all the enabled codecs and negotiates a common codec with the other party.

You cannot change the properties of any codecs.
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Video Codecs

This panel shows all the video codecs that are included in X-Lite. You can enable or disable codecs as desired. 

Typically, leave the enabled codecs list at its default state; only enable or disable a codec if advised to do so by 
your VoIP service provider.

With only one codec enabled, all calls made will use that particular compression format. With more than one 
codec enabled, X-Lite offers all the enabled codecs and negotiates a common codec with the other party.

You cannot change the properties of any codecs.
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Preferences – Calls
These settings let you configure how you want auto answer to handle incoming calls, when Auto Answer is 
enabled. (To enable Auto Answer, see page 11).

Field Description

DTMF You may need to change the DTMF configuration if you cannot interact with interactive voice 
response systems (auto attendants, voice-activated menus, and so on).
Contact your VoIP service provider for the correct setting.

RTP This timer controls how calls are disconnected when X-Lite determines that there is a problem 
with the call and the other party has probably disappeared (assuming that you have not yourself 
detected the problem and hung up manually).
Typically, the timer is enabled. It is recommended that you not disable it.
You can change the length of the timer, but do not set it to less than 30 seconds.

Preserve bandwidth When this feature is on, X-Lite stops sending audio when you are not talking.
When this feature is off, X-Lite always sends audio, which uses more bandwidth but may result 
in better call quality.
Typically off. However, if you are using a slow (dial-up or ISDN) connection, you may want to 
turn it on. 
44



A Troubleshooting
From the menu bar, choose Help > Troubleshooting. The Troubleshooting window appears.

Testing Audio Quality
While you are on a phone call, you can test the quality of the audio. Note that to perform a valid test, you should 
be on an established call (not a call attempt).  
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Testing Video Quality
While you are on a phone call, you can test the quality of the video. Note that to perform a valid test, you should 
be on an established call (not a call attempt). 
46



X-Lite for Mac User Guide
Testing Audio Devices
You can verify that your microphone and speakers are working and can set the volume to a comfortable level 
without having to actually place a phone call. 
F
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Diagnostics
If you have contacted CounterPath Customer Support in order to troubleshoot a problem, you may be asked to 
generate a diagnostic log and send it to CounterPath.

Click

Select the problem you 
are experiencing

Click

Click

Perform the actions you 
want to capture

When done, click Advanced again to open 
the dialog.

The report is sent. Close this 
window

Click to stop logging

Then click to choose a 
log file to send.
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B Application Hot Keys

Category Function Keyboard Shortcut

Making or answering a call Answer an incoming call Ctrl + N

Decline an incoming call Ctrl + D

Place an audio call Ctrl + P

Redial the last dialed number Ctrl + R
or Ctrl + R then Enter

End the call
End the conference call (hang up on all participants)

Ctrl + E

During a call Mute your voice during a call Ctrl + M

Hold or resume the call when the focus is on this call 
panel

Ctrl + H

Opening a window Open the Messages window Shift + Apple key + M

Open the Preferences window Apple key + , (comma)

Open the Test Devices window Ctrl + 9

Open the Video window Shift + Apple key + V

Hiding Hide X-Lite Apple key  + H

Exiting Quit X-Lite Apple key  + Q
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C Dial Plan
When a call attempt is made, the call input (what you type or select in the call entry field) can be modified to 
ensure that the call gets placed successfully. This ability to modify the input relies on the existence of a “dial 
plan” for the account.

C.1 Dial Plan Syntax
The dial plan has the following syntax:

pattern[|pattern];match=1;<transformation>=<value>;[match=2;
<transformation>=<value>;]

Where:

• Items in [ ] are optional. 
• Pattern: the pattern that will be matched. One or more patterns. Each pattern is separated by a | pipe. The 

pipe is optional after the last pattern. Each pattern is implicitly numbered, starting from 1.
• Match; Transformation: A pair that identifies the pattern number to compare with the input, and the 

transformation to perform on the input when a match is obtained. The transformation is optional (meaning 
that if there is no transformation for a pattern, then the input that matches this pattern is not transformed). 
One or more pairs.
“match=” is a literal. “n” identifies the pattern. “transformation=” is replaced by a keyword, see below. 
“value” is replaced by a value.

Spaces are allowed only in the <value> items. 

Example
\a\a.T|xxxxxxxxxx;match=1;prestrip=2;match=2;pre=8;

where:

• \a\a.T is the first pattern.
• xxxxxxxxxx; is the second pattern.
• match=1;prestrip=2; is the first match-transformation pair.
• match=2;pre=8; is the second match-transformation pair.

Pattern

Valid Content
The content for a pattern follows the digit map rules of RFC 2705, supplemented by the rules for regular 
expressions. Where there is an overlap between the digit map and regular expression rules, the digit map rules 
apply. For this reason, there are some special cases, included in the table below.

Remember that dial plans are applied after the input has been cleaned up!
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The following table describes the most common elements. All regular expression elements are supported.

Transformation Keywords

Order of Transformations
These transformations are always performed in the following order (the order in which the transformations are 
entered in the dial plan is not significant):

prestrip  >  poststrip  >  pre >  post  >  replace

Element Origin Description

| Regular 
expression rules

Pipe character, used to separate patterns.

0 1 2 3 4 5 6 7 8 9 Literals Literal digits, used as is. 

# * a to z Literals Literal characters, used as is. Special cases: 

• The literal x character is represented by \x.
• The literal t character is represented by \t.

x Digit map rules Wildcard for any single digit, 0 to 9. 

\a Regular 
expression rules

Wildcard for any single alphanumeric character.

[digit-digit] Regular 
expression rules

A digit within the specified range.

[character-
character]

Regular 
expression rules

A character within the specified range.

[digit1, digit2, 
digit3]

Regular 
expression rules

One of the characters in the collection.

. Digit map rules Repeat the last element 0 or more times. For example, xxxx. means repeat the last x 0 or 
more times, which means this pattern matches three or more digits (not four or more 
digits)! Use of this element results in a pattern with “minimum requirements”. 

T Digit map rules A timeout period will take place before automatic dialing starts.

The T timer forces X-Lite to wait after a match is made. This timer should always be 
included in these situations:

• Any pattern that uses the . (dot). For example, if the pattern is xxxx. then adding a 
timer lets you type three or more digits. If there is no timer, then as soon as you type 
three digits, X-Lite makes the match as soon as you type three digits. 

• Any dial plan that has two patterns that are similar in elements but different in length. 
For example, if one pattern is xxx and the other pattern is xxxxxxx, then adding the 
timer lets you continue typing past three digits, in order to get a match on the second 
pattern.

In this situation, the T timer should be included in the shorter pattern. 

Keyword Description

prestrip Strip the first n characters from the input before placing the call.

poststrip Remove n number of characters from the end of the input before placing the call.

pre Add the specified account prefix to the input before placing the call.

post Attach the specified postfix to the input before placing the call.

replace Replaces the input with the specified string before placing the call.
51



CounterPath Corporation
C.2 How the Input Is Processed

Comparing Input to the Dial Plan Patterns
The input is compared to the dial plan. Keep in mind that the input being compared is different depending on 
whether the input is dragged/selected or typed:

• If the input is dragged or selected, then the entire input is compared to the dial plan. 
• If you are typing the input, then the digits are compared one by one as they are entered. Each time a new 

digit is entered, the comparison starts over.

Results of the Comparison
X-Lite finds a match according to the following rules.

C.3 Examples

Example 1
\a\a.T|xxxxxxx.T;match=2;pre="9"

This simple example shows how to differentiate between a PSTN number and a softphone address, and how to 
add a “9” dialing prefix only to the PSTN number. 

Example 2
3xxT|1xxxxxxxxxx|[2-9]xxxxxxxxx|+x.T;match=2;pre="9";
match=3;pre="91";match=4;prestrip=1;pre="9011"

Type of Match Result If User Presses Enter or Call Result if User Stops typing

The input matches the pattern and the 
pattern does not include the T timer

The transformation is performed. X-Lite  
attempts the call.

Nothing happens even after the T timer 
has expired.

The input matches the pattern and the 
pattern includes the T timer

The transformation is performed. X-Lite  
attempts the call.

The transformation is performed. X-Lite  
attempts the call.

The input does not match the pattern No transformation is performed. X-Lite 
attempts the call.

Nothing happens even after the T timer 
has expired.

3xxT The first pattern is any three-digit number beginning with 3. No transformation. The 
assumption is that this is an internal extension. The timer forces X-Lite to wait after detecting 
a three-digit number beginning with 3, in case you are actually dialing a local call starting 
with 3. 

1xxxxxxxxxx The second pattern is any eleven-digit number beginning with 1. Prefix with 9 and dial as is. 
The assumption is that this is a long-distance PSTN call within North America (within North 
America, all long-distance calls start with 1).
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[2-9]xxxxxxxxx The third pattern is any ten-digit number beginning with a number other than 1. The 
assumption is that this is a local PSTN call within a ten-digit dialing zone. 

+x.T; The fourth pattern is a number of any length that begins with +, to indicate an international 
PSTN call from North America. Delete the +, prefix with 9011 (011 is the number to access 
an international line from North America).

match=2;pre="9"; For the second pattern, prefix 9 to access an outside line.

match=3;pre="91"; For the third pattern, prefix 9 and 1 to access an outside line and enter the long-distance code.

match=4;prestrip=1;
pre="9011"

For the fourth pattern, remove the + and prefix 9011 to access an outside line and enter the 
international code.
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D Exporting Contacts
You can export a contact list to a comma-separated file.

1. From the menu bar, choose Contacts > Export Contacts. The Export Contacts wizard starts. 

2. Select the file type and file location for the created file. 

A file of the specified type is created.
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E Glossary
Broadband Broad or wide bandwidth. In data transmission, the wider the band, the more data it is 

possible to transmit in a given time span. A cable, DSL and ADSL connection to the 
network provide broadband for data transmission. A dialup or ISDN connection 
typically provide a narrow bandwidth for data transmission.

Codec The format by which audio or video streams are compressed for transmission over 
networks. Codecs can be categorized as either narrowband or wideband: Narrowband 
codecs work with low bandwidth such as a dialup internet connection. These codecs 
have a sampling rate of 8 kHz. Wideband codecs work with high bandwidths and 
result in better audio quality. However, they do not work with PSTN. These codecs 
have a sampling rate of 16 kHz.

Dial plan The rules that X-Lite follows in order to interpret the softphone address or phone 
number that the user has entered and to modify the number or address, as required, to 
ensure that the call will be placed successfully. 

DTMF Dual-tone multi frequency. DTMF is the system that is used in interactive voice-
response menu systems such as the menu system for accessing voicemail messages. 
The DTMF system allows the user to interact with the menu by pressing keys on a 
dialpad or keyboard.

Firewall A technology that prevents unauthorized people connecting to your computer and to 
the applications running on the computer.

IM Instant Messaging. A technology that lets users send text message and files for near 
instantaneous delivery and display on each others’ computers.

MWI Message Waiting Indicator. An indicator that there is a voicemail message for the 
owner of an account.

Narrowband In data transmission, the wider the band, the more data it is possible to transmit in a 
given time span. A cable, DSL and ADSL connection to the network provide 
broadband for data transmission. A dialup or ISDN connection typically provide a 
narrow bandwidth for data transmission.

Presence An instant messaging feature that allows users to share information about their online 
status.

PSTN Public Switch Telephone Network. The traditional land-line phone network.
SIP account An account that provides the user the ability to make VoIP phone calls. The account 

encapsulates the rules and functions the user can access.
Softphone address The address used to connect to a SIP endpoint. In other words, the “phone number” 

used in a VoIP phone call. For example, sip:joseph@domainA.com.
USB device Universal Serial Bus device. A device that follows a specific communications VoIP

Voice over Internet Protocol. A variation of IP used for sending voice data over the 
internet, in other words, used for making phone calls over the internet.

VoIP service provider A business that provides a VoIP service, allowing a user to connect to the internet in 
order to make VoIP phone calls using X-Lite. The VoIP service provider sets up a SIP 
account for the user. 
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